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Supplementary Notes  

Supplementary Note 1. Fluorescence measurements of droplets using Image J (Fiji)  

Step 1: Image Input 

1. File > Open... (Load image) 

2. Image > Color > Split Channels 

3. Select blue channel 

Step 2: Adjusting Brightness and Contrast (B&C) 

1. Image > Adjust > Brightness/Contrast... (Adjust B&C) 

2. Use the adjustment sliders or click Auto to adjust the brightness and contrast. 

Step 3: Measuring ROI (Background) Intensity 

1. Select the Ellipse Tool from the toolbar or press E. 

2. Draw an ROI (Region of Interest) over the background area. 

3. Analyze > Measure (or press Ctrl+M). 

Step 4: Subtracting Background Mean 

1. Plugins > Math > Calculator Plus 

2. Subtract Background Mean: Set the operation to Subtract and input the mean background 

intensity value measured in Step 3. 

Step 5: Measuring ROI (Other Background) Regions 

1. Repeat Step 3 for additional background regions to measure their intensity. 

Step 6: Measuring ROI (Droplets) Intensity 

1. Select the Ellipse Tool from the toolbar or press E. 

2. Draw an ROI over a droplet. 
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3. Analyze > Measure (or press Ctrl+M). 

Supplementary Note 2. Sample size calculations based on Cochran’s equation for finite 

population.  

These calculations were used to estimate the sample size from the mid- and high-level sorted 

population with 95% confidence level. 

𝑛! =
"!∙$	∙	('($)

*!
 Cochran’s Equation for infinite population 

Where: n0 = sample size for infinite population,  z = 1.96 for 95% confidence level, p = fraction 

of the population exhibiting the trait, e = margin of error.  

𝑛 = 	 +"
',#"$%&

  Cochran’s Equation for finite population 

Where: n = the sample size for finite population, N = population size.  

Case 1: Lowering the threshold that includes mid- and high-level strains (85-100% percentile) 

using binary sorting based on the histogram generated in Figure 4 and Table S3 for threshold gating 

and using IDY1 as sample calculation example. 

Considering a ± 5% margin of error and using a binary sorter at a lower threshold of 85% 

percentile: 

1) Obtaining high-level strains (95% percentile) from recovered binary sorted strains. 

The variable p represents the proportion of the population that exhibits the trait, in this case, high 

enzyme activity. To calculate p, we first determined number of droplets within the 95% percentile 

and the total within the binary sorting threshold (> 85% percentile) based on the histograms in 

Figure 4 and Table S3. We then calculated the Proportion of > 95% Percentile samples over the 
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sorted sample population as listed in Table S3. This value was subsequently multiplied by the 

binary sorting efficiency, which is approximately 90.2% (refer to Figure S6). 

e = 0.05, p = 0.3157 and N = 8145 sorted droplets which is the amount of droplets sorted 

within the threshold of > 85% percentile (Figure 4 and Table S3). 

𝑛! =
'../!∙!.0'12	∙	('(!.0'12)

!.!1!
= 	331.97 ≈ 332    

𝑛 = 	 003
',''!$%(%)*

= 319.03	 ≈ 320	𝑠𝑎𝑚𝑝𝑙𝑒𝑠	  

2) Obtaining mid-level strains (85-95 % percentile) from recovered binary sorted strains.  

The variable p represents the proportion of the population that exhibits the trait, in this case, mid 

enzyme activity. To calculate p, we first determined number of droplets within the 85-95% 

percentile and the total within the binary sorting threshold (> 85% percentile) based on the 

histograms in Figure 4 and Table S3. We then calculated the Proportion of 85-95% Percentile 

samples over the sorted sample population as listed in Table S3. This value was subsequently 

multiplied by the binary sorting efficiency, which is approximately 90.2% (refer to Figure S6). 

e = 0.05, p = 0.5863, and N = 8145 sorted droplets which is the amount of droplets sorted 

within the threshold of > 85% percentile (Figure 4 and Table S3). 

𝑛! =
'../!∙!.14/0∙	('(!.14/0)

!.!1!
= 	372.72 ≈ 373    

𝑛 = 	 020
','+'$%(%)*

= 356.71	 ≈ 393	𝑠𝑎𝑚𝑝𝑙𝑒𝑠	  

Case 2: Mid- and high-level strains (85-100% percentile) using multiplexed sorting (two 

thresholds) based on Figure 4 and Table S3 for threshold gating and using IDY1 as sample 

calculation example. 
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Considering a ± 5% margin of error and using a multiplexed sorter (i.e. two thresholds): 

1) Obtaining high-level strains (95% percentile) from the multiplexed sorted strains. 

The variable p represents the proportion of the population that exhibits the trait, in this case, high 

enzyme activity. In this context, the proportion of samples exceeding the 95% percentile is 

determined solely by the efficiency of the multiplexed sorting, which is 98.6%, as shown in Figure 

2. 

e = 0.05, p = 0.986, and N =  2833 droplets which is the amount of droplets sorted within 

the threshold of > 95% percentile (Figure 4 and Table S3). 

𝑛! =
'../!∙!..4/	∙	('(!..4/)

!.!1!
= 	21.21	 ≈ 22	    

𝑛 = 	 33
',!!$%!(''

= 21.84	 ≈ 22	𝑠𝑎𝑚𝑝𝑙𝑒𝑠	  

2) Obtaining mid-level strains (85-95 % percentile) from the multiplexed sorted strains. 

The variable p represents the proportion of the population that exhibits the trait, in this case, mid 

enzyme activity. In this context, the proportion of samples from 85-95% percentile is determined 

solely by the efficiency of the multiplexed sorting, which is 98.6%, as shown in Figure 2. 

e = 0.05, p = 0.986, and N = 5312 droplets which is the amount of droplets sorted within the 

threshold of 85-95% percentile (Figure 4 and Table S3). 

𝑛! =
'../!∙!..4/	∙	('(!..4/)

!.!1!
= 21.21	 ≈ 22	    

𝑛 = 	 33
',!!$%*'%!

= 21.91	 ≈ 22	𝑠𝑎𝑚𝑝𝑙𝑒𝑠  
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Supplementary Note 3. Statistical analysis for picking colonies from plates 

The analysis below was adapted from Shih et al.[1]. 

𝑃567+8 = 𝑥 where, Pwrong and x = are the probability of incorrect trait in the sub-populations 

𝑃698:; = 1 − 𝑥 where, Pright = is the probability of correct trait in the sub-populations 

 

Based on our simple size sample calculations we should assay at least 22 single mutant colonies, 

therefore, we chose to assay 24 colonies. To determine the worst-case scenario for failure of 

assaying the desired trait, we would have had at least 98.6% (sorting efficiency) chance of 

observing at least one incorrect mutant.  

 

Given the failure probability x, the probability of having at least one out of n=24 mutants is 

mathematically:  

1 − (1 − 𝑥)+ 	≥ 0.986, to solve for x 

(1 − 𝑥)+ 	≥ 1 − 0.986   

(1 − 𝑥)3< 	≥ 0.014   

(1 − 𝑥) ≥ (0.014)
%
!)   

𝑥 ≤ 1 − (0.014)
%
!)   

𝑥 ≤ 1 − 0.8394   

𝑥 ≤ 0.1606  

𝑥	 ≤ 16% chance of finding an incorrect trait in the population (worst case scenario)  
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Supplementary Note 4. Calculation for ethanol yield and concentration and fermentation 

efficiency 

Based on the fermentation weight loss (CO2 released from the reactor), from the mass balance 

from glucose to ethanol and carbon dioxide, we could calculate the ethanol content in the end of 

the fermentation:  

𝐶/𝐻'3𝑂/ → 2𝐶3𝐻/𝑂	 + 2𝐶𝑂3 Chemical equation for alcoholic fermentation. 

For 2 mols of Ethanol generated, 2 mols of carbon dioxide is released, based on their molar mass:  

MWEthanol = 46 g/mol 

MWCO2 = 44 g/mol  

Conversion of mass of CO2 to Ethanol is:  

𝑚=;:>+7? =	𝑚@A! ∙
</8
<<8

  

1- Calculation of theoretical ethanol conversion based on the sugar content in the synthetic 
media, which is ~ 0.555 g of sugar in the 3mL aliquots used for fermentation.  

𝐸𝑡ℎ𝑎𝑛𝑜𝑙	𝐶𝑜𝑛𝑣𝑒𝑟𝑠𝑖𝑜𝑛	;:*76*;9B>?(𝑔) = 	
!.1'8	=;:>+7?
8	7C	DE8>6D

∙ 0.555	𝑔	𝑜𝑓	𝑠𝑢𝑔𝑎𝑟 = 0.283𝑔	𝐸𝑡ℎ𝑎𝑛𝑜𝑙   

2- Experimental yield of ethanol over biomass.  

𝑌*F$*69G*+;>?(𝑔) = 	
G,-./#01
H97G>DD

	, where methanol is calculated based on CO2 release.   

3- Fermentation Efficiency calculated based on the mass of ethanol generated by fermentation 

over the ethanol theoretical conversion.  

𝐹𝑒𝑟𝑚𝑒𝑛𝑡𝑎𝑡𝑖𝑜𝑛	𝐸𝑓𝑓𝑖𝑐𝑖𝑒𝑛𝑐𝑦	(%) = 	100%	 ∙ G,-./#01
=;:>+7?	@7+I*6;97+	-.2032-45/1
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4- Ethanol volumetric concentration based on the conversion of ethanol mass to volume using 

density of 0.789g/mL, and the fermenters volume of 3 mL. 

𝐸𝑡ℎ𝑎𝑛𝑜𝑙	𝑐𝑜𝑛𝑐𝑒𝑛𝑡𝑟𝑎𝑡𝑖𝑜𝑛	 RI
I
%S =	 G2-./#01

!.24.	∙	J7?EG*	7C	G*K9>
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Supplementary Tables 

Table S1. Number of droplets produced and collected for the multiplexed efficiency assay. The 
ratio of droplets containing 0.1 mM fluorescein, 1 mM fluorescein, and PBS is 1:1:5, and the same 
total volume of droplets were generated for each specific volume.  

 

Number of droplets in 
50 µL 

Droplet volume (pL) 
30 110 1,000 

PBS  1,190,476 324,675 35,714 

0.1 mM Fluorescein 238,095 64,935 7,143 

1 mM Fluorescein 238,095 64,935 7,143 

Total generated 1,666,667 454,545 50,000 

` 

Table S2. Calculated growth rates for diastatic yeast growing in different droplet volumes based 
on the logistic growth model, where r is the rate constant and YM is the maximum population.  

IDY1 IDY2 
Droplet size 

(pL) r (h-1) YM 
(cells/droplet) 

Droplet size 
(pL) r (h-1) YM (cells/droplet) 

1000 0.096 9.25 1000 0.06 7.00 

110 0.05 5.83 110 
Unstable

* 
4.53 

30 0.037 5.37 30 0.091 4.01 
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Table S3. Descriptive statistics of histogram of two diastatic yeast mutant population based in 
the droplet’s fluorescence data.  

Analysis IDY1 IDY2 

Total sample size 55603 45034 

85%-95% Percentile sample size (Figure 4) 5312 4244 

>95% Percentile sample size (Figure 4) 2833 2406 

Sorted sample population size 8145 6650 

85% Percentile Threshold 0.75-0.87 0.72-0.82 

85%-95% Percentile samples / total population 0.096 0.094 

Proportion of 85%-95% Percentile samples / sorted 

sample population 
0.65 0.64 

95% Percentile Threshold >0.87 >0.87 

>95% Percentile samples / total population 0.051 0.053 

Proportion of > 95% Percentile samples / sorted sample 

population 
0.35 0.36 
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Table S4. Fermentation results for selected mutants and wild type of IDY1 strain, fermentation 
rate based on CO2 release calculated based on the logistic growth model, statistical summary of 
One-way ANOVA of Ethanol Yield at 95% CI compared to WT - P values: 0.1234 (ns), 0.0332 
(*), 0.0021 (**), 0.0002 (***), <0.0001 (****). 

Strain rate 
(h-1) 

Yield (g 
Ethanol · g 
biomass-1) 

Average 
yeast 

biomass 
(mg) 

Statistical 
Summary 

to WT 

Ethanol 
Concentratio

n (% v/v) 

Fermentatio
n Efficiency 

(%) 

IDY1-M23 0.144 8.51 17.85 **** 6.43 53.69 

IDY1-WT 0.147 5.46 30.15 - 6.96 58.16 

IDY1-H3 0.122 4.69 30.70 * 6.08 51.40 

IDY1-M2 0.144 3.38 45.13 **** 6.44 53.83 

IDY1-H2 0.113 3.33 44.23 **** 6.22 51.99 

IDY2-M9 0.128 4.43 36.66 **** 6.87 57.47 

IDY2-M22 0.105 3.63 39.60 * 6.08 50.85 

IDY2-H13 0.109 3.58 41.70 ns 6.31 52.83 

IDY2-H23 0.094 3.13 50.03 - 6.63 55.39 

IDY2-WT 0.096 2.97 49.20 ns 6.19 51.73 
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Table S5. List of equipment, vendor and serial number used in autonomous multiplexed sorting.   

Component Vendor Serial No. 

Low-pressure neMESYS pump 

system 
Cetoni N/A 

TREK high-voltage amplifier Advanced Energy Inc. PZD700A 

Keysight function/arbitrary 

waveform generator 10 MHz 
Keysight Technologies 33210A 

Linear DC Power Supply with 4 

Channels 
GW Instek America Corp. GPE-4323 

Inverted microscope Olympus IX73 

Vibration-dampening bench Thorlabs N/A 

Filter block  FOFMS-UV 

Multichannel LED light source Ocean Optics MCLS 2073 

Bandpass filters Thorlabs 
FB450-40 and FL457.9-

10 

UV LED light source Thorlabs M375F2 

Hamamatsu ORCA-Flash 4.0 Hamamatsu N/A 

Flame spectrometer Ocean Optics N/A 

Optical fibers Thorlabs 
FG105UCA, FG200UEP 

and FG200LCC 
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Table S6. COMSOL Multiphysics parameters for modeling flow rate and electric field profile of 
multiplexed sorter device. 

Property Value 

Cr Electrical Conductivity 7.9 x 106 [S/m] 

Dielectric Thickness SU-8 5 7.0 [μm] 

Electrode Gap Width 25 [μm] 

HFE 7500 Electrical Conductivity 3x10-8 [S/m] 

HFE 7500 Oil Relative Permittivity 5.8 

PDMS Density 970 [kg.m-3] 

PDMS Electrical Conductivity 4 x 10-13 [S/m] 

PDMS Relative Permittivity 2.75 

Reference Pressure Level 1 [atm] 

Reference Temperature 293.15 [K] 

SU8-5 Electrical Conductivity 2.8x10-14 [S/m] 

Su8-5 Relative Permittivity 4.5 
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Supplementary Figures 

 
Figure S1. Design of the droplet-digital microfluidic sorter device. A) The overall device which 
was designed with two inlets (droplets and spacer oil) and three sorting outlets and has three main 
regions. B) Sorting electrodes configuration showing two actuation electrodes – one for each 
sorting channel and one ground electrode. The gap between electrodes is 25 µm. C) Sorting area 
dimensions with two identical sorting channels and one waste channel with bigger width. D) 
Dimensions of droplet spacing area – exiting droplet noddle designed with 50 µm to fit only one 
droplet based on the sizes from Ø 30 – 100 µm. E) Design of the detection area showing optical 
fibers channels for excitation Ø 105 µm fiber and Ø 200 µm emission fiber. Emission channel was 
fabricated with two layers fabrication ( ~ 200 µm height) to fit the optical fiber.  F) Device 
fabrication side view – three main layers (PDMS, dielectric and chromium electrodes).  
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Figure S2. Design and dimensions of droplet generator for different sizes of droplets. A) Design 
of a single droplet generator with two aqueous inlets to mix fluorescence substrate and cell 
population for single cell droplet generator using a T-junction design. B) Design of a double 
droplet generator for characterization of sorter efficiency with two aqueous inlets with individual 
oil inlets. Design used to make fluorescein and PBS droplets in a single device. C) Dimensions of 
the T-junction to generate droplets of different sizes (30 pL, 110 pL and 1 nL) – channels were 
fabricated with height (h) and width (w) with 1:1 ratio. D) 3D simulation comparing the 
dimensions of the three different droplet sizes used in this work.     
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Figure S3 – COMSOL numerical simulations showing the behavior of droplets as they approach 
the sorting area and are directed toward the waste channel when the electrode deactivated. These 
simulations illustrate variations in flow velocity patterns influenced by different oil spacer flow 
rates. Arrows within the simulations highlight the flow's inclination to divert towards channels 
with lower resistance. The color scheme used in the simulations delineates the velocity patterns 
within the two sorting and waste channels. 
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Figure S4 – COMSOL simulation of the electric field above the electrodes. This model includes 
a channel layer with a PDMS boundary and an HFE 7500 domain, along with a 7 µm thick 
dielectric layer and three electrode terminals. The simulation presents the electric field strength 
(measured in V/m) at heights of 0 and 50 µm (above dielectric layer) when the sorting electrode is 
actuated with different VRMS settings at 15 kHz.  
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Figure S5 – 3D COMSOL Simulation of Electric Field Strength: A) Schematic and side view in 
the x-z plane, illustrating the layout of the sorting and waste channels. B) Electric field strength in 
the x and z planes, adjusted by applying varying potentials. C) Schematic and side view in the y-z 
plane of the sorting and waste channels. D) Electric field strength in the y and z planes with 
different potentials applied. This model includes a channel layer with a PDMS boundary and an 
HFE 7500 domain, a 7 µm thick dielectric layer, and three electrode terminals. The simulation 
details the electric field strength (in V/m) at the entire height of the channels above the dielectric 
layer when the sorting electrode operates at different VRMS settings at 15 kHz. E) Side view 
comparison of the electric field in the sorting area relative to droplets of different sizes, 
demonstrating field strength perpendicularly with the droplets flow (black arrow). 
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Figure S6. Sorter Efficiency as a Binary Sorter to Test Design Efficiency. A) Comparison of 
sorting of 1mM fluorescein droplets mixed with PBS droplets between two different sorting 
channels. Efficiency is quantified by the proportion of fluorescent droplets in each respective 
sorting channel (SC1 or SC2) relative to the total number of droplets in that channel. False 
negatives (Fn) represent the percentage of fluorescent droplets in the waste channel. Error bars 
representing standard deviation N>3, Unpaired t-test at 95% CI - P values: 0.1234 (ns), 0.0332 (*), 
0.0021 (**), 0.0002 (***), <0.0001 (****). B) Fluorescence histograms used for gating in the 
autonomous sorting of three different droplet sizes. 
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Figure S7 – Time series of fluorescence detection of droplets of 30 pL mixture of 1mM fluorescein 
and PBS droplets (1:1 ratio).  A) Graph showing detection of 10 Hz droplet detection with 0.3 
nL·s-1 droplet re-injection flow rate and 200 nL·s-1 spacer oil flow rate. Expanded view showing 
peaks detected overtime (PBS droplets < 1 a.u. – blue line, and 1 mM fluorescein > 2 a.u. – green 
line). B) Graph showing detection of 160 Hz droplet detection with 3 nL·s-1 droplet re-injection 
flow rate and 300 nL·s-1 spacer oil flow rate. Expanded view showing peaks detected overtime 
(PBS droplets < 0.25 a.u. – blue line, and 1 mM fluorescein > 0.4 a.u. – green line).  
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Figure S8. Fluorescence histograms used for gating the autonomous multiplexed sorting of 1 mM 
fluorescein (dark green), 0.1 mM (light green) and PBS (blue) droplets mixture of different droplet 
sizes.  

 

 
Figure S9. Enzyme activity of diastatic yeast strains compared to positive and negative 
glucoamylase controls. A) Enzymatic assay performed using 4-Nitrophenyl β-D-maltoside as 
substrate. B) Enzymatic assay performed using 4-Nitrophenyl α-D-glucopyranoside. Error bars 
representing standard error N=3, One-way ANOVA at 95% CI compared to IY1 - P values: 0.1234 
(ns), 0.0332 (*), 0.0021 (**), 0.0002 (***), <0.0001 (****).  
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Figure S10. Enzyme activity of diastatic yeast strains compared to the negative glucoamylase 
controls. Enzymatic assay performed using 4-Methylumbelliferyl-α-D-glucopyranoside with 
reaction stopped with buffer pH 11. Error bars representing standard error N=3, One-way ANOVA 
at 95% CI compared to IY1 - P values: 0.1234 (ns), 0.0332 (*), 0.0021 (**), 0.0002 (***), <0.0001 
(****).  

 

 

Figure S11. Enzyme activity of commercial glucoamylase performed using 4-Methylumbelliferyl-
α-D-glucopyranoside with reaction stopped with buffer pH 11 and pH 7.5. Error bars representing 
standard deviation N=3.   
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Figure S12. Overnight enzyme activity of diastatic yeast strains compared to the negative 
glucoamylase controls using 4-Methylumbelliferyl-α-D-glucopyranoside pH 7.5. Fluorescence 
was taken while yeast culture growth in YPD media. Error bars representing standard deviation 
N=3.  
 

 

 

 

 

 

 

 

  



24 
 

 

 
Figure S13. Analysis Workflow for Measuring Fluorescence Intensity in Droplets. The raw 
fluorescence microscopy image is loaded into the analysis software (Step 1) and adjusted for 
brightness and contrast (Step 2). A background ROI is selected, and its mean intensity is measured 
(Step 3). This mean background intensity is subtracted from the entire image (Step 4). Additional 
background ROIs are measured for consistency (Step 5). Finally, ROIs within the droplets are 
measured for fluorescence intensity, corrected by subtracting the background mean (Step 6). 
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Figure S14. Comparison of maltodextrin growth of self-mated population (SMP) and the wild 
type (WT) by measuring optical density (OD). A) IDY1 strains. B) IDY2 strains. Error bars 
representing standard deviation N=6. 
 

 
Figure S15. Comparison of enzyme activity of glucoamylase produced by a self-mated population 
(SMP) and the wild type (WT). A) IDY1 strains. B) IDY2 strains. Unpaired t-test at 95% CI - P 
values: 0.1234 (ns), 0.0332 (*), 0.0021 (**), 0.0002 (***), <0.0001 (****).  Error bars representing 
standard error N=3.  
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Figure S16. Fold improvement of IDY1 and IDY2 mutant strains compared to wild type under 
two incubation periods: 24 hours (white bars) and 48 hours (green bars) in maltodextrin media. A) 
Medium and High IDY1 mutants showing the fold improvement for growth in maltodextrin. B) 
Medium and High IDY2 mutants showing the fold improvement for growth in maltodextrin. Error 
bars represent the standard error. The red dashed line marks the wild type, and red highlighted 
mutants are the selected ones for further fermentation experiments. 
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Figure S17. Fold improvement of IDY1 and IDY2 mutant strains compared to wild type under 
two incubation periods: 24 hours (white bars) and 48 hours (green bars) for glucoamylase activity. 
A) Medium and High IDY1 mutants showing the fold improvement for enzyme activity. B) 
Medium and High IDY2 mutants showing the fold improvement for enzyme activity. Error bars 
represent the standard error. The red dashed line marks the wild type, and red highlighted mutants 
are the selected ones for further fermentation experiments.
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Figure S18.  Decision tree for selecting mutant strains based on enzyme activity and maltodextrin growth. This decision tree outlines 
the selection criteria for mutant strains exhibiting higher traits compared to the wild type after sorted into two different populations: 
mid-fluorescence (M) and high-fluorescence (H).  
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Figure S19. Software and Hardware block diagram. This diagram illustrates the electronic control 
system for the droplet-digital microfluid sorter device. Optical fluorescence intensity data is 
captured and relayed to a flame spectrometer, which converts the readings into Relative 
Fluorescence Units (RFU) on a host computer using "uFlow control" software 
(https://bitbucket.org/shihmicrolab/fahmadi2023uflowcontrol). Upon reaching the preset 
fluorescence threshold, the software transmits a signal through a Teensy microcontroller to a port 
expander, which in turn actuates the sorting electrodes via optocouplers to control droplet sorting. 
Red dotted lines indicate USB connections, green dotted lines represent I2C connections, blue 
dotted lines show optical fiber connections, and solid black lines to electrical wire connections. 
Autonomous sorting software available to download at 
(https://bitbucket.org/shihmicrolab/f_ahmadi_2023_uflowcontrol).[2] 
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Figure S20. 3D Printed Chip Holder. Diagram illustrating a chip holder designed for 
accommodating various components essential for multiplexed sorting experiments. The central 
rectangular area labeled "Chip area" is where the droplet-digital sorter is placed. Excitation optical 
fiber holder and "Emission optical fiber holder are designed to facilitate the positioning of optical 
fibers for excitation and emission detection, respectively. The Electrodes (Pogo pin) clip holder is 
designated for securing electrodes. Microcentrifuge tube holder is included for holding 
microcentrifuge tubes, which could be used for sample preparation or collection. The layout 
ensures that all components are securely held in place, providing a stable setup for experimental 
procedures. 

 

 

 

 



31 
 

 

Supplementary References  
[1] S. C. C. Shih, G. Goyal, P. W. Kim, N. Koutsoubelis, J. D. Keasling, P. D. Adams, N. J. 

Hillson, A. K. Singh, ACS Synth. Biol. 2015, 4, 1151–1164. 

[2] F. Ahmadi, H. Tran, N. Letourneau, S. R. Little, A. Fortin, A. N. Moraitis, S. C. C. Shih, 
Small 2024, 20, 2308950. 

 
 


